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Abkürzungen 
 
CAN Controller Area Network Serielles Kommunikationsprotokoll 
I/O-Box Input/Output box Optionale Box zur Verbindung von Sensoren 

und um beliebige Lasten zu schalten. 
SCC STEYR CONTROL CENTER  
SCCWinConfig STEYR CONTROL CENTER 

Konfigurationssoftware 
Dieses Handbuch beschreibt diese Software. 

 

Einleitung 
 
Mit der STEYR CONTROL CENTER Konfigurationssoftware können Sie ihr STEYR CONTROL 
CENTER konfigurieren. Die Konfiguration des SCCs kann geändert und auf der Festplatte 
im STEYR CONTROL CENTER Pool gespeichert werden. Weiters ist es möglich ein an den 
PC angeschlossenes SCC direkt über ActiveSync zu konfigurieren. 
Für Archivierung oder Kopierzwecke können Sie die gesamte Konfiguration eines 
angeschlossenen SCCs im STEYR CONTROL CENTER Pool speichern. 
Die Konfiguration der gespeicherten oder geänderten SCCs kann auf ein angeschlossenes 
SCC übertragen werden. 
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Installation 
 

Microsoft ActiveSync 

Microsoft ActiveSync muss auf dem PC installiert sein um ein STEYR CONTROL CENTER 
verbinden zu können. Dies ist notwendig um auf die Konfiguration zugreifen und diese 
bearbeiten zu können. 
Wenn ActiveSync bereits installiert ist, und eine Verbindung mit dem SCC möglich ist 
brauchen sie ActiveSync nicht mehr installieren. 
 
So können Sie prüfen ob eine Verbindung mit ActiveSync zwischen dem SCC und dem PC 
möglich ist: 
In den ActiveSync Verbindungseinstellungen muss die USB Verbindung aktiviert sein. 
Schalten Sie das SCC ein und verbinden Sie es mit dem mitgelieferten USB Kable zum PC. 
Die Verbindung wird automatisch hergestellt. Verneinen Sie die anschließende Frage bzgl. 
Partnerschaft, da eine Gastverbindung ausreichend ist um ein SCC zu konfigurieren. 
 

STEYR CONTROL CENTER Konfiguration Software 

Für die Installation führen Sie einfach das Setupprogramm "InstallSCCWinConfig.msi" der 
Setup-CD aus, bzw. laden Sie die neueste Version aus dem Internet herunter. 
ACHTUNG: Deinstallieren Sie bereits vorhandene Versionen dieser Software bevor Sie die 
neue Version installieren. 
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Benutzeroberfläche 

Hauptfenster 

 
Bild 1: Anwendungsfenster 

 
Menü: Anwendungsmenü 
 
Werkzeugleiste: mit dem "Speichern" Symbol werden Änderungen im STEYR CONTROL 

CENTER Pool auf der Festplatte bzw. dem über ActiveSync verbundenen 
SCC gespeichert. 

 
Navigationsfenster: in diesem Bereich werden alle im STEYR CONTROL CENTER Pool 

gespeicherten SCC und das über ActiveSync verbundene SCC 
angezeigt. 

 
Datenfenster:  abhängig vom ausgewählten Element im Navigationsfenster werden hier 

alle einstellbaren Daten angezeigt. 
 
Statuszeile: in dieser Zeile werden kurze Beschreibungen über den ausgewählten Menü- 

bzw. Kontextmenüeintrag angezeigt. 
 

Navigationsfenster Datenfenster 

Statuszeile 

Menü 

Werkzeug-
leiste 
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Anwendungsmenü 

 
Menü "File": 

• "Save Ctrl+S": speichert alle Änderungen auf die Festplatte 
bzw. überträgt Änderungen auf ein über ActiveSync 
verbundenes SCC 

• "Exit": beendet die Anwendung. Falls Änderungen gemacht 
aber noch nicht gespeichert wurden, wird eine Warnmeldung 
angezeigt. 

 
 
 
 
Menü "Option": 

• "Set path of SCC pool …": legt den Speicherort auf der 
Festplatte fest wo der STEYR CONTROL CENTER Pool 
abgelegt werden soll. 

 
 
 
 
Menü "View": 

• "Toolbar": zeigt oder versteckt dir Werkzeugleiste 
• "Status Bar": zeigt oder versteckt die Statuszeile 

 
 
 
 
Menü "Help": 

• "About SCCWinConfig …": zeigt Versionsinfos 
 
 
 
 
Werkzeugleiste: 
 

•         Gleich wie Menü "File" -> "Save" 
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Navigationsfenster 

 
 
Symbole: 
 

     Symbol für STEYR CONTROL  
        CENTER Pool 
 

     Unterordner 
 

      STEYR CONTROL CENTER 
 

      I/O-Box 
 

      Relaisausgang 
 

      Sensoreingang 
 

      über ActiveSync verbundenes SCC 
 
 
 

Bild 2: Navigationsfenster 
 
Unterhalb des Hauptelements "STEYR Control Centers" können Unterordner und STEYR 
CONTROL CENTERs angelegt werden. Unterordner sind sinnvoll, um eine Struktur in die 
vorhandenen SCCs zu bekommen. Verwenden Sie zum Beispiel je einen Unterordner pro 
Kunde oder Boot. 
Das zweite Hauptelement "Connected SCC" wird nur angezeigt wenn ein SCC über 
ActiveSync zum Computer verbunden ist. Dieses verbundene SCC kann gleich wie die im 
Pool gespeicherten SCCs behandelt werden. 
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Arbeiten mit der Anwendung 

STEYR CONTROL CENTER Pool: 

 
Der STEYR CONTROL CENTER Pool ist ein Verzeichnis auf der Festplatte oder ein 
beliebiges Speichermedium auf das mittels Laufwerksbuchstaben zugegriffen werden 
kann. Der Pool kann aus Unterordnern und oder gespeicherten SCCs zusammengesetzt 
sein. In Unterordnern können weitere Unterordner angelegt und SCC gespeichert werden. 
Als Standardverzeichnis für den SCC Pool wird  "SCCPool" im Installationsverzeichnis dieser 
Anwendung verwendet. Dieses Verzeichnis kann über das Menü "Options" -> "Set path of 
SCC pool …" eingestellt werden. 
 

Welche Daten eines SCCs können konfiguriert werden? 

• Zeitzone 
• Getriebeübersetzung 
• Propellersteigung 
• Fassungsvermögen und Warnschwelle für den manuellen Tank 
• Einheiten 
• CAN Verhalten 
• Default I/O-Box 
• I/O-Boxen 

 

Umgang mit der Benutzeroberfläche 

 
Erstellen, Löschen, Umbenennen, Kopieren oder Transferieren von Objekten (Unterordner, 
SCCs, I/O-Boxen, Ausgänge oder Eingänge) wird über das Kontextmenü durch Rechtsklick 
eines Elements im Navigationsfenster mit der Maus erledigt. 
 
Neue Elemente werden immer als Unterelement des im Navigationsfenster ausgewählten 
Elements hinzugefügt. 
 
Um die Konfiguration eines Objekts (SCCs, I/O-Box, Ausgang oder Eingang) zu Ändern, 
wählen Sie das dazugehörige Element im Navigationsfenster aus. Nach der Auswahl 
werden alle änderbaren Einstellungen im Datenfenster angezeigt. 
Wichtig: beim Eingeben von Gleitkommazahlen immer den Punkt als Kommazeichen 
verwenden (z.B. "15.7"). 
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Geänderte Einstellungen im SCC Pool speichern 

 
Nachdem Einstellungen geändert wurden, müssen diese bevor die Anwendung beendet 
wird gespeichert werden (z.B. über Menü "File" -> "Save"). 
Einige Änderungen werden sofort in den SCC Pool übernommen ohne das Speichern 
explizit ausführen zu müssen, diese sind: 

• Umbenennen eines Unterordners oder SCC 
• Löschen eines Unterordners oder SCC 
• Anlegen eines neuen Unterordners oder SCC 
• Kopieren von SCCs 

 

Geänderte Einstellungen des verbundenen SCCs speichern 

 
Jede Änderung die am verbundenen SCC durchgeführt wird, wird temporär auf der 
Festplatte und nicht direkt im verbundenen SCC gespeichert. D.h. bevor die Anwendung 
beendet oder das SCC vom Computer getrennt wird, müssen die Einstellungen explizit 
gespeichert ("transferiert") werden. 
Nach dem Transferieren der Einstellungen muss das SCC neu gestartet werden, damit die 
neuen Einstellungen ihre Wirkung zeigen. 
Werden geänderte Einstellungen nicht transferiert, dann gehen diese beim Beenden der 
Anwendung oder Trennen des SCCs verloren. 
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STEYR CONTROL CENTERs konfigurieren 

Hinzufügen eines neuen Unterordners 

 
Klicken Sie im Navigationsfenster mit der rechten Maustaste entweder auf das Element 
"STEYR CONTROL CENTERs" oder auf einen bestehenden Unterordner. Wählen Sie 
anschließend im angezeigten Kontextmenü "New Folder" aus und geben Sie einen Namen 
für den neuen Unterordner ein. 
 

Hinzufügen von neuen STEYR CONTROL CENTER 

 
Klicken Sie im Navigationsfenster mit der rechten Maustaste entweder auf das Element 
"STEYR CONTROL CENTERs" oder auf einen bestehenden Unterordner. Wählen Sie 
anschließend im angezeigten Kontextmenü " New STEYR CONTROL CENTER " aus und 
geben Sie einen Namen für das neuen SCC ein. Das neue SCC wird mit 
Standardeinstellungen an der ausgewählten Stelle hinzugefügt. 
 

 
Bild 3: neues SCC hinzufügen 
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 STEYR CONTROL CENTER konfigurieren 

 
Bild 4: Einstellungen eines SCCs 

 
Wird ein SCC im Navigationsfenster ausgewählt, so können dessen Einstellungen im 
Datenfenster, wie im Bild oben gezeigt, verändert werden. 

Allgemeine Einstellungen eines SCCs 

 
• Zeitzone: diese Einstellung ist wichtig wenn ein GPS Sensor zum STEYR CONTROL 

CENTER verbunden ist, da dieser die ermittelte Zeit auf UTC Basis übergibt. 
Erlaubte Werte: alle einstellbaren aus der Liste 

• Getriebeübersetzung: Faktor zum Berechnen der theoretischen Geschwindigkeit 
und des Schlupfs. 
Erlaubte Werte: jede positive Dezimalzahl (z.B. 2.1) 

• Propellersteigung: gleiche Verwendung wie Getriebeübersetzung 
Erlaubte Werte: jede positive Dezimalzahl (z.B. 20) 

• Fassungsvermögen Tank: des manuellen Tank 
Erlaubte Werte: jede positive Ganzzahl 

• Warnschwelle: fällt der aktuelle Inhalt unter diese Schwelle, dann wird vom SCC 
ein Warnhinweis anzeigt. 
Erlaubte Werte: jede positive Ganzzahl und "-1". "-1" bedeutet, dass keine 
Warnschwelle angezeigt werden soll. 
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• Einheiten: Einheiten mit denen Geschwindigkeits-, Temperatur-, Druck- und 
Volumenwerte angezeigt werden sollen. 
Erlaubte Werte: jede Auswahl 

• CAN Verhalten: es ist möglich mehr als ein SCC auf derselben CAN Leitung an 
unterschiedlichen Orten zu verbinden, um z.B. an einem anderen Ort auf dem 
Boot Motor- und Sensordaten einsehen oder I/O-Box Ausgänge schalten zu 
können. Beim Start der Anlage initialisiert das "Master SCC" alle 
angeschlossenen I/O-Boxen und "Slave SCCs" mit wichtigen Werten für die CAN 
Bus Kommunikation. Aus diesem Grund muss und darf ein "Master SCC" nur 
genau einmal pro CAN Bus vorkommen. Für eine funktionierende 
Kommunikation zwischen Motor, SCCs und I/O Boxen muss genau ein "Master 
SCC" vorhanden sein, es dürfen beliebig viele "Slave SCCs" verbunden werden, 
"Slave SCCs" müssen aber nicht vorhanden sein. 
Erlaubte Werte: siehe Beschreibung oben 

 

Elemente unterhalb eines SCCs im Navigationsfenster 

 

 
Bild 5: Elemente unterhalb eines SCC Elements 

 
 

• "Default I/O-Box": 
Jedes SCC hat einen "Default I/O-Box" Eintrag, diese I/O-Box kann gleich wie 
jede andere I/O-Box konfiguriert werden mit Ausnahme der Seriennummer. 
Diese Konfiguration wird verwendet wenn das SCC eine neue oder unbekannte 
I/O-Box erkennt. SCCs erkennen I/O-Boxen anhand deren Seriennummern. 
Empfohlene Einstellungen: wird nur eine I/O-Box verwendet, dann sollten diese 
und die Default I/O-Box exakt gleich konfiguriert werden. Dies hat den Vorteil, 
dass beim Austausch der I/O-Box auf Grund eines Defektes keine 
Neukonfiguration mehr notwendig ist. 
 

• "I/O-Boxes": 
Der "I/O-Boxes" Ordner kann eine beliebige Anzahl an konfigurierten I/O-Boxen 
enthalten, die dem STEYR CONTROL CENTER bekannt sind. 
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Hinzufügen einer neuen I/O-Box zum STEYR CONTROL CENTER 

 

 
Bild 6: Hinzufügen einer neuen I/O-Box 

 
Klicken Sie im Navigationsfenster mit der rechten Maustaste auf den "I/O-Boxes" Ordner 
unterhalb des SCCs zu dem Sie die neue I/O-Box hinzufügen wollen. Im darauf folgenden 
Kontextmenü wählen Sie "Add new I/O-Box" aus und geben einen beliebigen Namen ein. 
Nach dem Bestätigen des "Enter name" Eingabefensters wird die neue I/O-Box mit Default 
Einstellung (von der "Default I/O-Box") zum SCC hinzugefügt. Anschließend muss sofort 
die Seriennummer für die neue I/O-Box eingestellt werden, der Wert Null ist nicht erlaubt. 
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I/O-Box konfigurieren 

 

 
Bild 7: konfigurierbare Daten einer I/O-Box 

 
Wird eine I/O-Box im Navigationsfenster ausgewählt, dann können die Werte, wie im Bild 
oben dargestellt, konfiguriert werden. 
 

Allgemeine I/O-Box Werte 

 
• Seriennummer: Seriennummer der I/O-Box für die diese Konfiguration gültig ist.  

Dieser Wert ist sehr wichtig, da das STEYR CONTROL CENTER anhand dieser 
Nummer die angeschlossenen I/O-Boxen erkennt und verwaltet. Das SCC weiß 
somit welche gespeicherte Konfiguration mit der I/O-Box zu verwenden ist und 
wie mit den empfangenen Daten umzugehen ist. 
Die Einstellungen einer I/O-Box sind immer im SCC und nicht in der I/O-Box 
selbst gespeichert. Der einzige Wert, der permanent in der I/O-Box gespeichert 
ist, ist deren Seriennummer. 
Erlaubte Werte: jede positive Ganzzahl mit Ausnahme von Null 

• Priorität: wenn mehrere I/O-Boxen gleichzeitig zum STEYR CONTROL CENTER 
verbunden sind, dann bestimmt diese Priorität die Reihenfolge der Anzeige im 
I/O-Box Fenster der SCC Anwendung. Null bedeutet die höchste Priorität und 
255 die Niedrigste. Haben eine oder mehrere I/O-Boxen dieselbe Priorität, dann 
ist die Reihenfolge zufällig. 
Erlaubte Werte: jede Schieberposition 
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Elemente unterhalb einer I/O-Box im Navigationsfenster 

 

 
Bild 8: Elemente einer I/O-Box 

 
• "Outputs": 

Der "Outputs" Ordner enthält die konfigurierten Relaisausgänge für eine I/O-
Box. Die Reihenfolge der Ausgänge im Navigationsfenster bestimmt die 
physikalischen Anschlusskontakte am Stecker für die Ausgänge an der I/O-Box. 
Der erste Ausgang in der angezeigten Reihenfolge entspricht dem ersten 
Relaissteckplatz am Ausgangsstecker (Pin 1 und Pin 12) der I/O-Box, usw. (für 
die Steckerbeschreibung der I/O-Box siehe die technische Beschreibung des 
SCC). 
 

• "Sensors": 
Der "Sensors" Ordner enthält die konfigurierten Sensoreingänge für eine I/O-
Box. Die Reihenfolge der Eingänge im Navigationsfenster bestimmt die 
physikalischen Anschlusskontakte am Stecker für die Eingänge an der I/O-Box. 
Der erste Eingang in der angezeigten Reihenfolge entspricht dem ersten 
Sensorsteckplatz am Eingangsstecker (Pin 1 und Pin 8) der I/O-Box, usw. (für 
die Steckerbeschreibung der I/O-Box siehe die technische Beschreibung des 
SCC). 
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Hinzufügen eines neuen Relaisausgangs zu einer I/O-Box 

 

 
Bild 9: Hinzufügen eines neuen Ausgangs 

 
Klicken Sie im Navigationsfenster mit der rechten Maustaste auf den "Outputs" Ordner der 
I/O-Box, bei dem Sie einen neuen Relaisausgang hinzufügen wollen. Im darauf folgenden 
Kontextmenü wählen Sie "Add new output" aus und geben einen beliebigen Namen ein. 
Nach dem Bestätigen des "Enter name" Eingabefensters wird der neue Ausgang mit 
Default Einstellung zur I/O-Box hinzugefügt. 
Es sind max. vier Relaisausgänge pro I/O-Box erlaubt. 
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Relaisausgang konfigurieren 

 

 
Bild 10: konfigurierbare Daten eines Ausgangs 

 
Wird ein Ausgang im Navigationsfenster ausgewählt, dann können die Werte, wie im Bild 
oben dargestellt, konfiguriert werden. 
 
 

Konfigurierbare Daten eines Ausgangs 

 
• Auto off time: Zeitspanne, nachdem sich ein eingeschalteter Ausgang automatisch 

wieder ausschaltet. 
Achtung: die Einheit dieses Wertes sind 1/10 Sekunden (ein Wert von z.B. "100" 
entspricht einer Dauer von zehn Sekunden) 
Erlaubte Werte: jede positive Ganzzahl. Null bedeutet, dass die automatische 
Ausschaltfunktion nicht verwendet wird. 

• Push button: wenn aktiviert, dann verhält sich die Schaltfläche in der I/O-Box 
Anzeige der SCC Anwendung wie ein Taster und nicht wie ein klassischer 
Schalter. D.h. ein Ausgang ist nur eingeschaltet solange die Schaltfläche 
gedrückt wird. 
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Reihenfolge der Ausgänge ändern 

 
Klicken Sie im Navigationsfenster mit der rechten Maustaste 
auf den zu verschiebenden Ausgang, wählen Sie im darauf 
folgenden Kontextmenü "Move up" oder "Move Down". 
Wiederholen Sie diesen Vorgang bis der Ausgang an der 
gewünschten Position steht. 
 
Der Ausgang an der obersten Stelle im Navigationsfenster entspricht der Schaltfläche links 
oben in der I/O-Box Anzeige der SCC Anwendung, der zweite Ausgang entspricht der 
Schaltfläche rechts oben, der dritte Ausgang der Schaltfläche links unten und der letzte 
Ausgang der Schaltfläche rechts unten. 
 

Umbenennen eines Ausgangs 

 
Klicken Sie im Navigationsfenster mit der rechten Maustaste auf den Ausgang der 
umbenannt werden soll, wählen Sie im darauf folgenden Kontextmenü "Rename output". 
Der Name des Ausgangs wird auf der dazugehörigen Schaltfläche in der SCC Anwendung 
angezeigt. 
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Hinzufügen eines neuen Sensors zu einer I/O-Box 

 

 
Picture 11: Add a new sensor 

 
 
Klicken Sie im Navigationsfenster mit der rechten Maustaste auf den "Sensors" Ordner der 
I/O-Box, bei dem Sie einen neuen Sensor hinzufügen wollen. Im darauf folgenden 
Kontextmenü wählen Sie "Add new sensor" aus und geben einen beliebigen Namen ein. 
Nach dem Bestätigen des "Enter name" Eingabefensters wird der neue Sensor mit Default 
Einstellung zur I/O-Box hinzugefügt. 
Es sind max. vier Sensoren pro I/O-Box erlaubt. 
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Sensoren konfigurieren 
 

 
Bild 12: konfigurierbare Daten eines Sensors 

 
Wird ein Sensor im Navigationsfenster ausgewählt, dann können die Werte, wie im Bild 
oben dargestellt, konfiguriert werden. 
 

Konfidurierbare Daten eines Sensors 

 
• Sensor type: siehe Beschreibung weiter unten 
• Sensor: In dieser Liste sind alle vordefinierten Sensoren des ausgewählten 

Sensortyps zu finden. Wird ein vordefinierter Sensor ausgewählt, dann werden 
alle Eingabefelder mit Ausnahme der Alarmbereiche voreingestellt. 
Wird "self defined sensor" ausgewählt, dann können alle Sensorwerte frei 
eingestellt werden. 

• Filter: Anzahl der zu ermittelnden Sensorwerte um eine Durchschnittswert für die 
Anzeige zu berechnen. Dies ist für Sensoren, die einen starken 
Schwankungsbereich aufweisen, sinnvoll (z.B. für Tanksensoren). Der 
berechnete Durchschnittswert wird in dem entsprechenden Instrument im I/O-
Box Fenster der SCC Anwendung angezeigt. Die I/O-Box ermittelt und sendet 
Sensorwerte ca. jede Sekunde einmal, es wird daher ein Filter von max. fünf 
empfohlen. 
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Erlaubte Werte: jede Schieberposition. Null und eins bedeutet, dass kein Filter 
verwendet wird, es wird jeder ermittelte Sensorwert direkt in der SCC 
Anwendung angezeigt. 

• Sensor max. value: ohmscher Widerstandswert, den der Sensor bei max. Anzeige 
hat. Achtung: die Einheit dieses Wertes ist 1/10 Ohm (z.B. eine Wert von 
"1000" entspricht 100 Ohm) 
Erlaubte Werte: jede positive Ganzzahl von 0 - 65535 

• Sensor min. value: ohmscher Widerstandswert, den der Sensor bei min. Anzeige 
hat. Achtung: die Einheit dieses Wertes ist 1/10 Ohm (z.B. eine Wert von 
"1000" entspricht 100 Ohm) 
Erlaubte Werte: jede positive Ganzzahl von 0 bis 65535 

• Scale max. value: Wert, der im Instrument am Ende der Skala angezeigt wird. 
Erlaubte Werte: Ganzzahl von -999 bis +999 

• Scale min. value: Wert, der im Instrument am Anfang der Skala angezeigt wird. 
Erlaubte Werte: Ganzzahl von -999 bis +999 

• Scale unit: Einheit der Werte "Scale max. value" und "Scale min. value". Achtung: 
Hierbei handelt es sich nicht um die Einheit der Insterumentenanzeige in der 
SCC Anwendung. Die Instrumenteneinheit wird in den allg. Einstellungen in der 
SCC Anwendung eingestellt. Die "Scale unit" wird verwendet, um zwischen den 
möglichen Anzeigeeinheiten umrechnen zu können. 

• Enable upper red region: aktiviert die Möglichkeit einen oberen roten Bereich 
und eine obere Alarmschwelle einzustellen. 

• Upper red region: Skalenwert bei dem der obere rote Bereich starten soll. 
Erlaubte Werte: Ganzzahl, Wert muss kleiner als "Scale max. value" und größer 
als "Scale min. value" sein. 

• Enable high alarm: wenn aktiviert, dann erscheint eine Warnfenster auf dem 
SCC, wenn ein Sensorwert den Wert in "Upper red region" überschreitet. 

• Engine must run: das Warnfenster für den oberen Alarm wird nur angezeigt wenn 
der Motor läuft. 

• Enable lower red region: aktiviert die Möglichkeit einen unteren roten Bereich 
und eine untere Alarmschwelle einzustellen. 

• Lower red region: Skalenwert bei dem der untere rote Bereich enden soll. 
Erlaubte Werte: Ganzzahl, Wert muss kleiner als "Scale max. value" und größer 
als "Scale min. 

• Enable low alarm: wenn aktiviert, dann erscheint eine Warnfenster auf dem SCC, 
wenn ein Sensorwert den Wert in "Lower red region" unterschreitet. 

• Calibration values: siehe "Kalibrierwerte" weiter unten. 
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Beschreibung der Sensortypen 

 
Mögliche Sensortypen sind: 
• "Empty sensor place":  

Wenn "Empty sensor place" ausgewählt ist, dann wird das entsprechende 
Zeigerinstrument in der I/O-Box Anzeige der SCC Anwendung als leer 
dargestellt. Dies wird benötigt, wenn der dazugehörige Sensorplatz am Stecker 
für Eingänge an der I/O-Box nicht verwendet wird. 

• "Fuel sensor": 
Füllstandssensoren für Treibstofftanks. Sensoren dieses Typs können in der 
Tank Anzeige der SCC Anwendung für die Anzeige ausgewählt werden. 

• "Temperature senor": 
Temperatursensoren 

• "Pressure sensors": 
Drucksensoren 

• "Digital sensors": 
Digitale Sensoren haben nur zwei Zustände: ein und aus wie ein Schalter. Die 
einzige Einstellmöglichkeit für digitale Sensoren ist: 
* Alarm wenn der Schalter geschlossen wird (null Ohm) 
oder 
* Alarm wenn der Schalter geöffnet wird (∞ Ohm) 
 
Vordefinierter digitaler Sensor "Screen off mode": 
Wenn dieser Sensor ausgewählt ist und der dazugehörige Schalter geschlossen 
wird, dann wird die Displaybeleuchtung des SCCs ausgeschaltet. Wird der 
Schalter wieder geöffnet, dann wird die Beleuchtung wieder eingeschaltet. 

• "Common sensor": 
Sensor ohne spezielle Bedeutung 

Kalibrierwerte 

 
Kalibrierwerte sind notwendig, um nicht lineare Sensoren zu definieren. 
Werden Sensoren ohne Kalibrierwerte definiert, dann wird der Skalenwert linear zwischen 
Minimum und Maximum berechnet. 
Kalibrierwerte bestehen immer aus zwei Werten: dem Widerstandswert in Ohm des 
Sensors und des dazugehörigen Skalenwertes des Zeigerinstruments. Dieses Wertepaar 
definiert einen Punkt der Sensorkurve, ein Sensor kann eine beliebige Anzahl solcher 
Wertepaare haben um seine Kennlinie zu definieren. 
Achtung: der Widerstandswert eines Kalibrierwertes muss in 1/10 Ohm angegeben 
werden. 
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Bild 13: Eingabemaske für Kalibrierwerte 

 
Die Reihenfolge der Wertepaare, die in der Eingabemaske für Kalibrierwerte aufgelistet 
sind, ist sehr wichtig: das Wertepaar mit dem niedrigstem Skalenwert muss am Anfang 
der Liste stehen, am Ende der Liste muss das Paar mit dem höchsten Skalenwert stehen. 
Der niedrigste und höchste Skalenwert muss nicht dem min. bzw. max. Skalenwert des 
Zeigerinstruments entsprechen. Es ist möglich mit den Kalibrierwerten irgendwo in der 
Mitte der Skalenbandbreite des Zeigerinstruments zu starten bzw. zu enden. 
 
Im Bild oben ist ein Sensor mit folgendem Verhalten zu sehen: Mit steigendem 
Widerstandwert des Sensors steigt auch das Zeigerinstrument. Es gibt aber auch 
Sensoren, wie z.B. Temperatursensoren (NTC’s), die sich genau umgekehrt verhalten: Mit 
steigendem Widerstandswert des Sensors fällt das Zeigerinstrument (siehe Bild unten). 
 

 

Bild 14: steigender Widerstand – fallendes Zeigerinstrument 
 

Achtung: Beim Definieren von Kalibrierwerten für Sensoren muss immer auf die 
korrekte Reihenfolge der Wertepaare geachtet werden. 
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Reihenfolge der Sensoren ändern 

 
Klicken Sie im Navigationsfenster mit der rechten Maustaste 
auf den zu verschiebenden Sensor, wählen Sie im darauf 
folgenden Kontextmenü "Move up" oder "Move Down". 
Wiederholen Sie diesen Vorgang bis der Sensor an der 
gewünschten Position steht. 
 
Der Sensor an der obersten Stelle im Navigationsfenster wird durch das Zeigerinstrument 
oben in der Mitte in der I/O-Box Anzeige der SCC Anwendung dargestellt, der zweite 
Sensor entspricht dem Zeigerinstrument unten links, der dritte Sensor dem 
Zeigerinstrument unten Mitte und der letzte Sensor dem Zeigerinstrument unten rechts. 
 

Umbenennen eines Sensors 

 
Klicken Sie im Navigationsfenster mit der rechten Maustaste auf den Sensor der 
umbenannt werden soll, wählen Sie im darauf folgenden Kontextmenü "Rename sensor". 
Der Name des Sensors wird im dazugehörigen Zeigerinstrument in der SCC Anwendung 
angezeigt. 
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Mit "Connected SCC" arbeiten 
 
Einstellungen direkt am verbundenen SCC ändern: 
Ist ein STEYR CONTROL CENTER mit dem Computer über ActiveSync verbunden, dann 
wird das Element  unten im Navigationsfenster angezeigt. Sie können das 
verbundene SCC ganz normal wie jedes andere SCC im Pool konfigurieren. Wenn Sie mit 
den Änderungen fertig sind, müssen Sie diese speichern (Menü "File" -> "Save") damit das 
verbundene SCC aktualisiert wird. Wird das SCC ohne zu speichern vom Computer 
getrennt, gehen alle Änderungen sofort verloren. 
Nach dem Speichern muss das SCC neu gestartet werden damit die Änderungen wirksam 
werden. 
 
Einstellungen eines SCCs aus dem Pool auf das verbundene SCC übertragen: 
Nachdem Sie die Konfiguration von SCCs im SCC Pool beenden haben, ist es gewünscht 
diese Einstellungen auf reale STEYR CONTROL CENTERs zu übertragen. Verbinden Sie zu 
diesem Zweck das SCC über ActiveSync mit dem Computer und wählen sie mit der rechten 
Maustaste das SCC im Pool aus, vom dem Sie die Einstellungen übertragen möchten. Im 
darauf folgenden Kontextmenü klicken Sie auf "Transfer STEYR CONTROL CENTER". Der 
Kontextmenüeintrag "Transfer STEYR CONTROL CENTER" ist nur aktiv, wenn ein SCC mit 
dem Computer verbunden ist. 

         
Bild 15: Transferieren von Einstellungen von und zu dem verbundenen SCC 

 
Kopieren des verbundenen SCCs in den SCC Pool: 
Um das verbundene SCC in den internen SCC Pool zu speichern, klicken Sie mit der 
rechten Maustaste auf das verbundene SCC und wählen "Copy connected STEYR 
CONTROL CENTER" aus. Klicken Sie nun im Navigationsfenster, wieder mit der rechten 
Maustaste, auf einen Ordner oder auf das Hauptelement "STEYR CONTROL CENTERs" und 
wählen Sie "Paste STEYR CONTROL CENTER" aus. Nach der Eingabe des Namens für das 
SCC wird dieses unterhalb des ausgewählten Ordners im Pool eingefügt.  
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Der "About SCCWinConfig" Dialog 
 
Zum Feststellen der Versionsinformationen und der verfügbaren vordefinierten Sensoren, 
wählen Sie das Menü "Help" -> "About SCCWinConfig…" aus. 
 
 

 
Bild 16: "About SCCWinConfig" Dialog 


